What’s changed in BOE XI 3.1?
On 05/24/2012, BOE was upgraded to a newer version. For the most part, things work just as they did before. However, there are a few key changes that are addressed in more detail later in this document:

- Need to get back to your list of reports? Click on the “Document List” menu option
- When scheduling reports, you must choose PDF or Excel or you will not be able to open the report instance.

Business Objects Enterprise (BOE) is the “back end” application that allows the viewing of Crystal Reports through a web browser. InfoView is the name of the web application used to run, view, and schedule reports online. We are simply referring to the whole package as “BOE”.

BOE is used to view accounting and HR/PY data processed and stored in our IFAS and other systems.

Supported Browsers
Windows Users
You can use Internet Explorer 8 or 9, or Firefox.

Internet Explorer Settings
Depending on your operating system and how your computer is configured, you might receive security warnings from Windows or Internet Explorer when you run InfoView. You can avoid potential problems by adding the Business Objects server, which is named fdnreports, as a trusted site in Internet Explorer. To do this:

1. Open Internet Explorer
2. Choose Tools > Internet Options > Security > Trusted Sites > Sites
3. Add https://fdnreports.calpoly.edu as a trusted site and click “Add”
   a. Don’t forget the “s” on the “https”
4. Click Ok
5. Click Ok

Mac Users
If you are using a Mac, you should be able to use either Safari or Firefox. However, when you print a report, it will first open in Adobe Acrobat. After it opens, you can use the print function of Adobe.

Logging into InfoView

- Use the following URL: https://fdnreports.calpoly.edu to access the InfoView log in screen. Enter your username and password
  o For CPC employees – use the same username & password as you use to log on to your computer in the morning
  o For ASI and CPSU users, use the username and password provided to you by the CPC IT department when your account was created.

*If you experience any problems logging in, contact the CPC Help Desk at x65900
There are many settings you can change in InfoView, but briefly, here are a few you may find useful:

- After clicking on the Preferences Icon you’ll see four categories:
  - General
  - Change Password
  - Desktop Intelligence
  - Crystal Reports

- General
  - **InfoView Start Page** - This is the screen InfoView will open to each time you log in.
    - You will probably find it useful to either choose “favorites” or “folder.”
      - Favorites will display your favorites folder and any shortcuts you’ve created (instructions for creating Favorites can be found later in this document)
      - If you pick “folder” you can select any folder available to you as a starting page. Just use the “browse folder” button to pick a folder to start in. Pick the folder you most commonly use.
  - **Document Navigation View:**
    - “Folder”
      - This is the recommended setting
  - **Set the number of objects (max.) per page:**
    - Change this number to **20**
  - **Document List Display:**
    - You can leave all four items checked here
  - **Document Viewing:**
    - You can experiment with these options, but in general, we recommend the third option: “In multiple full screen browser windows, one window for each document”

- Change Password
  - This is only used if you are a University user, and wish to change your password.

- Desktop Intelligence
  - We do not use this product so you can ignore this section

- Crystal Reports
  - The only item you might change here would be for the printing control.
    - Choose PDF if you always want to print your reports to PDF
    - Choose ActiveX one-click printing if you want to send reports directly to the printer after previewing them.

- Once you have made any desired changes, click “OK” and they will be saved.

**Navigating Reports in InfoView**
In InfoView, the left side of your screen will show a navigation tree consisting of folders. Which folders you see will depend on your security. At a minimum, you will always have the following:
Clicking on the “+” next to a folder will expand that folder. The sub folders will then be displayed below, like this:

- My Folders
- Public Folders
  - Business Objects Delivered
  - HEAT
  - IFAS Financials
  - IFAS HR/PY
  - System

Alternately, you can just click on the folder, and its contents will be displayed in the right hand pane of InfoView, like this:

- The “My Favorites” folder is user configurable; use it to place shortcuts to frequently run reports.
- The Inbox can be used to receive reports from other users
- Public folders – this is where the Financial and HR/PY reports are located.
  - There are separate folders for HR/PY and Financial reports. You may not have access to both.

Running/Viewing Reports

- To run a report, double click the report name
  - This will bring up the prompt screen

Viewing reports
- This is the contents of the Purchasing folder.
Depending on how you have configured InfoView, the prompt screen may open in a new tab, a new window, or, within InfoView itself. See “Document Viewing” in the “Preferences” section above to change this setting.

- Any prompt that is highlighted in yellow indicates that it is a “smart prompt.” Smart prompts will generate a list of pick values as soon as you start typing in the field. For example:
  - In a prompt for “fiscal period,” typing “m” will bring up a list that includes March and May. Typing “01” will bring up July.
  - Once the value you want to use is highlighted, you can tab out of the field to accept the response.
  - Use the calendar control when possible to avoid date formatting problems.

- Respond to all prompts & click “View Report”
- A new tab or window will open (depending on how you have your browser configured) and your report will appear once it has completed.

- To run the same report again with different parameters
  - Close the report you just ran, change the parameters, and run the report again
- If you ever need to get back to where you started, just click on “Document List” at the top of the screen.

Scheduling Reports

- To schedule a report, right click on the report name and choose “Schedule.” You will have a set of questions you must answer to run a report, but as a basic practice, you’ll only need to set “Recurrence,” “Parameters” and “Format”.
  - **Instance title** – you can label the “instance” of your scheduled report whatever you would like or leave it as is.
  - **Recurrence** – specifies when you want to run a report.
    - If you choose ‘Once’, for example, you will be prompted to enter a date & time.
  - **Parameters**
    - When you click on parameters, you’ll get a list of all the parameters needed for a report.
      - Click on the “edit” button or the word “empty” for each parameter, add or change the value, then click OK.
  - **Filters** – do *not* change anything here.
  - **Format**
    - Choose either “PDF” or one of the Excel formats.
  - **Destination**
    - Generally, leaving the default value of “Default Enterprise Location” gives you the most flexibility when the report has completed, and ensures that row level security is maintained.
    - BOE can email the report or a link to the report once it is complete – see “Emailing BOE Reports” later in this guide.

- **Print Settings**
  - You can schedule a report to automatically print once it has completed running, but the setup can be tricky, and it is probably best to just schedule the report,
preview the results, and then print the report. This way you won’t waste any paper printing a report that did not contain the data you were looking for.

- **Events** – you can ignore this section
- **Scheduling Server Group**
  - We currently do not use server groups, so ignore this section.

When you are done with scheduling parameters, click “Schedule”
- Once you have clicked “Schedule,” you’ll be taken to the History page, where you can see the status of your newly scheduled report
- Click on “Refresh” to update the status of your running report

- Your report will initially be in “Pending” status but will change to “Success” when complete.
- To view the completed report, click on the “Instance Time” and the report will open.

**History**

- When you right click on a report and choose “History” you’ll be taken to the History screen. Here you’ll see all the instances of the report, as well as currently scheduled reports.
- An instance is a previously scheduled run of a report that already contains data. On Demand reports do not create instances; only scheduled reports do.
- When you click on an instance to view it, it does not re-run the report; it shows the data as it was requested for that particular run
  - To view an instance in history, click on the “Instance Time”

  - Clicking on an instance status (Success, failure) will show the report for the parameters specified at the last run
  - If you did not schedule the report, row level security may prevent you from seeing any data
- You can choose to only view your instances by checking the “Show only instances owned by me” check box at the top of the History window:

- With the exception of GL Month End reports, all instances are deleted from the system after 7 days.

**View Latest Instance**

- Right clicking a report and choosing “View Latest Instance” label will show you the instance from the last report that was run
  - Depending on the report – this may not be useful to you, as the parameters used for the last instance may not be relevant.
- **Viewing reports that have “Groupings”**
  - Some reports will be structured to have group totals. These reports will have a “Group Tree” that will appear in the left hand frame when you are viewing a report.

  ![Group Tree Example](image)

  - Clicking on one of these group values will take you directly to that section of the report.
  - Some groups will have sub groups. In that case, clicking the plus sign next to the group name will show the sub group. You can then click on the sub group to jump directly to that section of the report.
  - You can hide the group tree simply by clicking the group tree button.

- **Exporting reports to other formats**
  Once a report has been run, the resulting data can be exported to other formats

  ![Export Options](image)

  On any report output window, click here to start the export process
  - Choose a file format
    - Excel 97-2000 results in a report that looks exactly the same as the onscreen report
    - Excel 97-2000 data only results in a spreadsheet version with columns & rows
  - Choose a page range & click ok
  - If you are exporting to excel, you will be prompted to “Open” or “Save” the report
    - If you choose Open, Excel will open with the report
      - You can then save the spreadsheet
    - If you choose Save, you’ll be prompted for a location to save the file

- **Printing Reports**
  Once you have run a report, either by viewing it on demand or by scheduling it, printing is simple. However, the way in which reports print is slightly different between Windows and Macintosh users, so please read on. In all reports, at the top left corner, you’ll see the printer icon:

  ![Printer Icon](image)

**Mac users**
Macintosh computers do not use the Active-X printer control. When printing from a Macintosh, the report will automatically be exported to Adobe Acrobat. Once in Acrobat, you can print the report normally, using File > Print from the Acrobat menu.

**Windows Users**
Clicking on the printer icon will bring up the standard Windows printing dialog box. You can choose which printer you would like to use, and which range of pages you would like to print.

**Internet Explorer 8**
The very first time you print, you will be prompted to install an Active-X printer control. You will only get this the first time you print. Allow the system to install the printer control and you will be taken to the printing dialog box once it’s complete.

So you don’t get prompted to install the printer control each time you print, you can take the following steps:

- Choose the “More Options” drop down box.
- Choose the “Always install….” Option
- Click the install button

**Internet Explorer 9**
If you have added *fdnreports* as a trusted site, you shouldn’t get any prompts – your report will just print. If you haven’t added *fdnreports* as a trusted site yet, then like IE 8, you’ll get prompted to install an ActiveX viewer, but the format of the prompts is a bit different.
*Update:* Many CPSU (State Employee) computer users may not have sufficient privileges on their PC’s to install the ActiveX print control needed to print the reports from the BOE system. There are two ways to deal with this. One is a work around, and one is permanent solution:

- **Work around:**
  - Instead of using the print icon in the upper left, use the "Export this report" icon (the disk icon just to the left of the printer icon).
  - For File Format, choose "Adobe Acrobat (PDF)" and click OK.
  - At the File Download prompt, click Open.
  - At this point the report has opened in Adobe Acrobat and you may print the report from here, using the print icon within the Adobe PDF viewer.

- **Permanent Solution:**
  - Your local LAN coordinator (or whoever manages your computers) can do one of two things:
    1. Temporarily elevate your privileges on your PC to “Administrator” until you log into BOE, run a report and then print it. Doing this will allow the ActiveX control to be installed
      - After successfully printing the report, your security level can be changed back to what it was originally.
    2. Your LAN coordinator could log into your pc as an administrator, and then allow you to log into BOE with your user ID, run a report and print it. Then the LAN coordinator could log out and have you log back onto your PC as yourself.
      - This will allow the ActiveX control to install
  - Regardless of which method is chose, once the ActiveX control is installed on your pc, it should work for anybody who uses it.

**Searching in reports**
You can search the contents of a report for things like key words and numbers after it has run, but it can be a bit cumbersome. To search a report, enter a word or number to search for in the search box, then click on the binoculars to initiate the search.

If the report contains multiple occurrences of the word or number you are searching for, you’ll have to scroll back to the top of the page, and click on the binoculars again to continue the search.

As an alternative, **export the report to PDF**, then, use the search functionality within Acrobat Reader. This works very well, and can help you find specific data in a lengthy report. A caveat to searching in Adobe though: Adobe treats everything as text strings. So, to search for the dollar amount of 7,135.35, you must type the number with commas and decimal places in the search box. If you simply type 7135.35, Acrobat will not find the number, as it is checking for exact matches.

**Adding reports to your “Favorites”**

You can add any report to your “Favorites” folder. To do so:

- Navigate to any report
- **Single** click on the report to select it.
- Click on the “Organize” drop down and choose “Copy Shortcut”
- Click on the “My Favorites” folder, or a subfolder you have created
- Click on the “Organize” drop down and choose “Paste Shortcut”
Advanced Topics

Emailing BOE Reports
You can schedule a BOE report and have the resulting Instance emailed in two different ways.

- To schedule a report so an actual copy of the report is emailed to a recipient, setup the destination area as follows: (see “Scheduling Reports” earlier in this document)

1. Choose “email” in the Destination drop down box
2. Uncheck “Keep an instance in the history”
3. Uncheck “Use default settings”
4. Enter your email address in the From box
5. Enter a valid email in the To box
6. Enter an appropriate subject line
7. Enter a message, if desired
8. Leave “Deliver Document(s) as Attachment” checked.
9. Choose “with automatically generated name” or “specific name”
   a. If you choose “specific name”
      □ Add a period at the end of the name
      □ Click on the “Add Placeholder” drop down list and choose “file extension.”
      □ This will automatically add the appropriate “dot” extension to the end of your file name.
   b. If you choose “automatically generated name” the correct file extension will be added for you, but the report name will be a system assigned series of numbers & letters.
10. In the “Format” section of the report scheduler, make sure choose a format other than “Crystal Report”